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The Beginner's Guide to Weebly—Part 1 
 

Weebly is an easy way to build a website of which you can be proud, but that doesn’t mean a little 

guidance can't make it even easier.  All the basics you need in order to put together your first (and 

second, third, fourth, even seventeenth) site can be found here in the Beginner's Guide.  Take a few 

minutes to read through it and you’ll be an expert in about the time it takes to fix a nice breakfast, 

maybe one that involves a big plate of pancakes.  

 

If you need extra help, go to www.weebly.com. Scroll to the bottom of the Home page. In the column 

titled More, select Support. There are topics you may select from or you have the opportunity to type in 

a question. 

 

Select a Theme 
 

The first step to create a site is to select a theme. There are well over a hundred themes to choose from 

and you can look over them by scrolling down our Choose a Theme page.  

 

 

 

 

http://www.weebly.com/
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See a theme you like? Then you can click right on it to select it.  It can be a little overwhelming to choose 

exactly which theme you want before you've even started working on your site, but don't fret as you can 

very easily change the theme later (and we'll show you how). For now just find a theme that looks good 

and select it.  After you pick a theme you'll be asked to give your site a title. If you don't have a title in 

mind yet, just think of a temporary title; much like the theme, the title can be easily changed later on.  
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Next you'll choose your site's address (also called a domain). This isn't particularly important until you've 

finished your site and published it, so if you don't already know which domain you want to use the 

simplest thing to do is to select a free subdomain of Weebly.com using the first option. Much like the 

theme and the title, this is yet another part of the site that's easy to change, and we'll cover domain 

names in more detail later in this guide. 

 

 

 

 

 

All done with the initial setup; you're now ready to start creating your site. 
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Add and Edit Text 
 

Adding text to your site is as easy as dragging any of our text elements to a page.  The primary text 

elements are Text, Image+Text, and Title.  

 

Let's drag the most commonly used text element -- the one with the rather appropriate name of "Text" -

- to this sample site.  

 

The text element is exactly what it sounds like: an element for writing text. Click inside the element to 

start writing.  

 

 

You can write a word, a sentence, or multiple paragraphs in a single element.  
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As you write, take note of the gray toolbar at the top of the element. This is the text toolbar and it 

allows basic changes to the formatting of your text. It works much like any other such toolbar normally 

works: select the text you want to change and click the appropriate button to make that change.  

 

From left to right, you can bold your text, italicize it, underline it, make it bigger, make it smaller, 

change the color, create a link, adjust the alignment of all text within the element, create bulleted and 

numbered lists, and remove formatting.  

   

Note: One thing you cannot do is change the font family to a different style. That particular setting is 

controlled elsewhere (but just as easily changed) and we'll dig into it later.   

 

 

 

 

To add more text to the page we could continue writing in 

this same element, drag on another paragraph element, or 

use one of the other text elements: 

 

Title: Used for adding titles / headers to a page. 

Paragraph w/ Title: A paragraph element with a place for 

a title already built in. 

Paragraph w/ Picture: A paragraph element with a place 

for both a title and an image built in. 

 

All of these elements use the same text editing toolbar we 

examined above and you can stack as many of them as 

needed on the page.  

 

Note: If you want to edit text directly from Word©, follow these steps: 

 Select the text in Word that you want to insert into your webpage. 

 Remove the formatting by clicking the Clear Formatting icon on the Home tab.  

 Once the formatting is clear, select Copy to copy the selected text. 

 Paste your text into your webpage element (Ctrl-V). 

  

http://kbprojectx.weebly.com/first-elements.html
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Adding Pictures to a Site 
 

Adding pictures to your site works in much the same way as adding text: by dragging an image element 

to a page.  

 

Click the Upload Image box to add a picture.  

 
 

This opens up a dialog box presenting several ways to add a photo. The two key options are to either 

upload (or drag) an image from your own computer or to search through the Weebly stock photo 

database.  
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Let's focus on the option to upload a photo from your own computer. (The easiest way to approach this 

is to drag the picture you want to use from your desktop into the box that quite helpfully says "drag 

photo here.") You can also click the green "Upload a photo" button if it isn't convenient to drag the 

image over.  Note: If possible crop your picture before uploading it! 

 

The size of a picture will vary after upload, but it'll usually show as wide as the entire site.  You can 

adjust the size of the image by clicking and dragging the little box that appears in the lower right corner 

of the image (you'll need to click on the picture to see it).   
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Clicking on the photo also opens up a settings dialog box that you can use to make further changes.  

 

Some notable controls: 

 

Lightbox: If you turn this on then any visitor who clicks the image on your site will be shown a larger 

version.  

Link: This option turns the image into a link. We cover links later in this guide.  

Spacing: Makes minor adjustments to the amount of white space around the picture.  

Caption: Lets you add a basic text caption under the pic.  

Advanced: Allows you to adjust (or turn off / on) the border around the picture.  

 

And the big blue "Edit Image" button opens up a simple image editor.  
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This editor provides some basic options for adding effects, lets you rotate the image to any angle and 

has a Crop feature that can cut unwanted parts of the image away.  

 

 

 

As an example of how these tools work, let's crop this picture a bit.  
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The Crop option places a box over the top of the picture. You can click on that box to drag it around and 

adjust the bubbles on the corners and sides to change the dimensions.  

 

Once you've made changes click OK. If you don't like the changes you can click Crop again to readjust or 

click the grey Cancel button to drop out of the editor. We've cropped the example image down to more 

of a square; we'll keep this change and click the Save button in the upper right.  
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And now the changes to the image are saved.  

 

 

 

Place Elements Side-by-Side with the Columns Element 
 

When you start adding elements to a page, you'll likely notice that they stack one on top of each other 

automatically. At first glance this may make it appear there's no way to place elements side-by-side.   

But the good news is that our Columns Element can be used to add up to five columns to a page. This 

enables you place elements right alongside each other (or to put space between or left and right of 

other elements). The Columns Element is dragged to a page just like any other element.  
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The element starts with two columns, but you can add up to five via the toolbar that appears when you 

scroll over the element. Just click the appropriate number.  

 

We'll stick with only two columns for this example, but regardless of the number of columns they all 

work the same way: you drag other elements into the columns.  

 

You can drag as many elements into each column as needed, and use the blue bar between the columns 

to adjust the width of each. Elements inside the columns will expand or contract as you change the 

column size.  
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The divider between the columns doesn't show up on the published site so none of your visitors will see 

that.   

 

 

 

 

You can add as many elements as you like to each column; they'll just stack on top of each other as 

usual.  And you can add elements above and below the Columns element too, so part of the page can 

have two columns, another part one column, and another could have five. That's entirely up to you.  
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The Beginner’s Guide to Weebly—Part 2 

 

Adding Pages to Your Site 
 

Regardless of whether you're a free customer or a subscriber to our Pro service, your site can have as 

many pages and sub-pages as needed; we place no limits whatsoever on the number of pages that can 

be added to a site.  Creating a new page is a matter of going to the Pages tab and clicking the Add Page 

button.  

 

There is an option to Add a Standard Page or Add a Blog. Selecting the Standard Page option adds a 

new page to your list.  
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Adding more pages is a matter of clicking Add Page and choosing Standard Page again (and again).  

As you add (and name) each of your pages, they'll automatically become part of your site's navigation 

bar.  

 

You can re-arrange the order of the pages by clicking and dragging them up and down the Pages list. 

Dragging a page to the top of the list will make that page your Home.  The Home page can be renamed 

to whatever you like; the name for this site's Home has been changed to Welcome. Changing the order 

of pages in the list will also change the order in which they're displayed in the navigation.  

 

You're also able to create subpages of other pages. You can do this by 

dragging a page or pages underneath and to the right of another page.   

 

These subpages appear in a drop-down menu when you scroll over the page 

to which you connected them.  

 

To edit the content of a page just click on its link from the navigation menu or 

go to the Pages tab, select the page from the list and click the Edit Page 

button.   
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Start a New Blog 
(Available only in Pro) 

 

Your site doesn't need to have a blog and you can skip this page if you don't want to have one.  

To create a blog, go to the Pages tab of the editor, click Add Page and select the Blog Page option.  

 

This will add the blog to your list of pages.  

 
 

Give the blog a name (if you want to call it something other than "Blog") and then click Save & Edit to 

start adding content.  
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A new blog starts with a sidebar with some 

default content that you can easily change, and 

also gives you the option to add a New Post.  

 

 

 

 

 

 

 

To create a new post for your blog, use that New 

Post button.   

 

Your blog post has a title and a content area.  The 

title should generally be short - no more than a 

sentence long or so.  The content area includes a 

basic paragraph element which you can either edit 

or delete. 

 

 

 

 

 

 

 

 

Adding content to a blog post works the same way 

as adding content to a regular page - just drag 

elements into the post and edit them to add 

content. 
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Once you've added your content you can categorize the post - these categories 

will appear on your sidebar, making it easier for visitors to find posts that cover 

specific topics.  Categories can be whatever you like and it isn't necessary to 

use them. If you do use them, we'd recommend having no more than twelve 

different categories on your entire blog.  

 

 

 

 

 

When you're done you can Publish the post to your live site (which will make it instantly available for 

visitors) or Save to Drafts to edit / publish it later.  

 

 

If you save the post as a draft, it'll be accessible to you through a drafts area at the top of the blog page 

from within the editor (along with any other drafts you've saved).  Just click the link to the post from this 

drafts area to edit it further and Save / Publish. 

 

Every new post you Publish will appear at the very top of the page, pushing older posts further down. 

After you've added seven or eight posts to the page, older posts will be moved off the main page to still 

accessible archive pages.   
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The Beginner's Guide to Weebly—Part 3 
 

How to Switch Themes 
 

As we saw on the first page of this guide, the very first step in creating a site is selecting a theme for that 

site. But that doesn't mean you're stuck with theme you selected. You can change your theme by going 

to the Design tab and selecting Change Theme.  

 

There are over a hundred themes to choose from and many of the individual themes include a variety of 

color choices that impact the look of different parts of that theme.  
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When you scroll over a theme you're given the option to Preview it.  

 

Previewing it shows exactly how your own pictures and content would appear in this new theme. If you 

like the theme you can Choose it, if you don't you can Cancel and look through some of the other 

themes.  You can sort the themes by categories and popularity, if you'd prefer not to scroll through all of 

them.   
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Edit Theme Fonts 
 

Each Weebly theme has default fonts for the Site Title, Paragraph Titles, Paragraph Text and Links. You 

can change these fonts using the Change Fonts area found under the Design tab. 

 

 

Site & Paragraph Titles 

 

The Site Title is the Title that appears (or may not appear if you delete it) at the top of every page of 

your site. 

 

The Paragraph Titles can be added to a page via the Title element:  

 Select a new Font Face from the drop-down menu. Select a new Font Size. 

 Change the weight of the font to make it heavier / thicker or lighter / skinnier.  

 Change the Font Color by clicking the color box. You can select another color here or even enter 

a specific HTML color code. 
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Paragraph Text 

 

The paragraph text is all the regular text on your site. Select a different Font Face from the drop-

down menu. 

 Select a new Font Size. 

 Change the weight of the font to make it heavier / thicker or lighter / skinnier.  

 Change the Font Color by clicking the color box. You can select another color or even enter a 

specific HTML color code. 

 Select a different Line Height. This adjusts the amount of white space between each sentence in 

a paragraph. 

 

 

Links 
 

 

Links connect people to other pages on your site, pages on other sites, 

email addresses and files that they may want to download.  

 

Change the color of an unclicked Link 

 

Change the Visited color (this color indicates to the site visitor that 

they've already looked at that link). 

Change the Hover color. This is the color given to the link when you 

hover the mouse over it. 

 

If you ever want to switch back to the default fonts for a section, just 

use the Reset link found within each section. 
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Edit the Header 
 

 

All of the themes include a 

header image at the top of 

each page. As it's doubtful 

you'll want to use this default 

image on any of your pages, 

we've made this header very 

simple to edit and change. To 

get started, scroll over the 

header image and click the 

Edit Image button: 

 

 

 

This will prompt you to either 

Add an Image or Use the 

Original Image. Choose to 

Add Image.  

 

 

 

 

 

 

 

 

This will open up a dialog box 

that allows you to upload an 

image from your own 

computer or to search for an 

image from our stock photo 

database.  
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Once you upload or find an image, you'll be able to edit that image. (This particular image is taller than 

the banner area.) 

 

But header images can be re-sized using the little bubbles at each corner and side of the image.   

 

And an image can be dragged to better fit the header by clicking anywhere on it and dragging it.  
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Use the provided tools at the top of the page to edit and add text / effects to the image as needed.  

 

 

When you're happy with an image, select the Save button to 

Save it.  You can use the arrow to the right of the Save 

button to choose whether to save the image to every page of 

the site, just this page or to select only certain pages to save 

it to.  In that way you can have different headers on different 

pages if you want.  

 

And here's how the page looks with the Saved image.   

 

Keep in mind that multiple images can be added to the same header just by Editing the header and 

clicking the Add Image button in the upper left.  
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The Beginner's Guide to Weebly—Part 4 
 

 

Upload a Gallery of Images 
 

The gallery element enables you to upload photos in bulk, which are arranged in a click-to-see-a-larger-

version grid format that you can control.  

 

Drag the Photo Gallery element (found under Multimedia) to a page to get started.  

 

 

 

Then click the Upload Images button that appears in the element.  
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And either drag images into the box or click the big green Upload Photos button.  

 

 

This will let you select images from your computer to upload.  You can select multiple images by holding 

the CTRL key on a PC or the Command key on a Mac.  If you have trouble uploading images, we'd 

recommend limiting the number of images you upload to no more than 25 at a time. You can always add 

more later.  

 

 

Give the photos a few minutes to upload and then you'll see your gallery on the page. 
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Each image in the gallery automatically links to a larger version of the image.  You can also link an image 

elsewhere (another site or page) if you like or add a caption that will appear on the enlarged version of 

an image.  Click on the gallery to see these options.   
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Click on thumbnails and drag them around to rearrange images within the gallery.  

 

 

The gallery's toolbox enables you to make additional changes. 

 

 

Add Images (there's no limit, but we recommend uploading no more than 200 images to one gallery). 

Determine the number of columns you want.  The default is 3, but you can use from 2 to 6. 

Select the amount of Spacing to place between each image. 
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And with Advanced, choose if you want a border around each thumbnail or not. And select if you want to crop the thumbnails to either squares 

or rectangles. This cropping has no impact on the enlarged images; it only changes the look of the thumbnails to make the gallery look more 

uniform.   

 

 

   

http://kb.weebly.com/uploads/4/5/0/0/4500922/2038508_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/5801661_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/2874023_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/9394558_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/7247291_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/7439959_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/1040491_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/4552714_orig.jpg
http://kb.weebly.com/uploads/4/5/0/0/4500922/9197445_orig.jpg
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Create an Image Slideshow 
 

Our slideshow element (available under the "Multimedia" category of elements) enables you to show 

off your photos with style.   To add a slideshow, drag the element to a page on your site. 

 

 

This will open the Choose a Slideshow Style dialog box where you can select which style of slideshow 

you want.  This can always be changed later (we even provide more options later), so don't spend too 

much time worrying about which one you want.  Let's select Thumbnails on Bottom for this example.  
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You'll now be prompted to upload photos.  Hit the big Upload Photos button or just drag some photos 

into the box to get started. 

 

 

Then select the photos you want to upload.  You can always delete photos / upload more later.   
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Depending on how many photos you selected, it may take them a few minutes to upload.  Once they're 

uploaded, you'll see them all on the photo management screen. 

 

 

 

You can drag photos to re-order them, click the "x" next to each to delete them and click the "bubble" 

icon to add a caption that'll appear along with the photo in the slideshow. When you're ready to move 

on, click Save and you'll see the slideshow as part of the page.   
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Click on the slideshow to open its toolbox and make changes.   

 

 Use the Add / Edit Photos button to bring up the Manage Photos dialog box we saw earlier.  

 Use Transition Style to switch between five different photo transitions.  

 Use Navigation to select whether you want to use Thumbnails, Numbers or no navigation at all.  

 Use Speed to determine how fast the slideshow should play.  

 Use Spacing the tweak the amount of space around the image.  

 Use Caption to determine if any text captions should appear at the top or bottom of each 

image.  

 With the Advanced option, set Autoplay to On or Off (it's on by default) and determine if you 

want the slideshow to always play in order or start from a random point every time the show is 

loaded.    

Note that the slideshow will automatically expand to the width of the page or column in which you've 

placed it.   
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The Beginner's Guide to Weebly—Part 5 
 

 

Both free and pro users can upload and link to pretty much any kind of document (allowing site visitors 

to download it) or embed a document so it is directly visible on a page.  Here's how to do both.  

 

Link to a Document (or Other File) 
 

You can create a link to a document either by highlighting the text you want to link or clicking on an 

image then selecting the appropriate link option for either. 

 

If you're linking text, it'll look like this: 

 

If you're linking an image, it'll look like this:  
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Either option will open a link dialog box from where you'll need to select the File tab on the left 

and then click the Upload a File button.  

 

 And then select the file you want to upload from your computer.  

 

Then you're all done.  The link will be live and clickable on your published site and your visitors 

will be able to download the file directly to their own computers.  
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Embed a Document to a Page 
 

You can also add a PDF, Word file, or other document directly to a page using our Embedded 

Document element (which is provided by Scribd). We do not recommend the use of this 

element; linking to the documents as described above is a much better way to provide access 

to them.   

 

Drag the element to a page (you can find it under the Multimedia section of Elements): 

 

 

Click the indicated area of the element and the select the Upload New File option from the 

toolbar.   
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Then select the file you want to upload from your computer.   

 

Give the file a little time to upload and you're all done!   
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The Beginner's Guide to Weebly—Part 6 
 

 

How Do I Save My Site? 
 

All of your work is saved as you go, so there is no need to do anything special to save your site.  It is 

saved for you automatically.  You can just close out of the editor and come back when you're ready -- all 

of the work you previously created will be there waiting for you.   

 

There is one exception where this is not true and that is if you're working on a blog post.  To save a blog 

post to work on later (before Publishing it), be sure to click the Save to Draft button at the top of the 

post.  

 

Publish a Site 
 

When you're ready, you can get your site out on the internet by publishing it.  You can do this at any 

point, and you can always add more content to the site later and publish it again. To publish a site, click 

the orange Publish button in the upper right corner of the editor.   
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This will bring up a verification box, letting you know your site has been Published.   

 

You can click the Published address to view your site, use the Facebook and Twitter buttons to link your 

friends and followers at either provider to your site, and click the "x" in the corner of the box to close 

the box and continue editing your site.   

 

 

How Do I Edit My Site After I Publish It? 
 

To edit your site after you first publish it, just log in through weebly.com (or through the Log In button 

on the upper right of this page), make your changes in the editor and publish the site again.  Any 

changes you've made to the site will immediately appear on the live site after you press the Publish 

button.  

 

Note that if you do not see the changes you've made after you publish the site, it's probably because 

your browser is displaying an older version of the page from its cache.  Just reload the page using your 

browser's reload/refresh button to bring up the newest version of your site.  

 

 

  



41 
 

Invite Other People to Edit Your Site w/ the Editors Tab 
 

The Editors tab enables you to invite any number of other people to help you edit an individual site.    

Under the Settings tab you'll find a section called Editors. Selecting the Editors section brings up a page 

where you invite / give other people permission to edit the site.  Click the Add Editors button to get 

started.  

 

This brings up the Add Editors toolbox.  

 

Enter the email addresses of the people you'd like to 

invite.  If more than one, separate the addresses by a 

comma.  You can invite more people later, so you don't 

have to invite everyone in this one go.   
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If you have Pro Service, then you can assign Roles to invitees.  These Roles limit which parts of the site 

each person is able to edit.  Let's take a look at the different Roles.    

 

An Administrator can edit all pages and access all stats, form entries and blog comments for this one 

site (but obviously has no access to any of your other sites unless you invite them to edit those other 

sites, too).  Note that free users can only invite Administrators -- the other Roles are accessible just to 

Pro Users.  

 

An Author can be limited so that they can only edit specific pages.  You can allow them to edit all pages, 

just one of the pages or any number of pages in-between.  Just check the box next to each page you'd 

like to allow them to edit. You can also disable their ability to publish the site themselves so that you can 

look things over before their changes are published.  

 

 

 

  

http://kb.weebly.com/faq-pro.html
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Dashboard-Only invitees cannot edit the site, but can instead only view the stats, form entries and blog 

posts associated with it.  You can even disable their access to any of this information.    

 

 

Enter a message of some kind to be included in the email invitation (unless you don't care to do so) and 

then click Add Editors.  

 
 

Your invitees will receive an email that includes a link that they'll need to click in order to access your 

site.   
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Once they click that link, they'll see your site as part of a separate list from their own sites (even if they 

don't have any of their own sites) within their account with us.  They'll then be able to access / edit the 

site based on the Role you've assigned them.  

 
 

 

All the people you invite are placed on a list under the same Editors section found under Settings.  You 

can change their Role or completely remove their access at any time via this list.  
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How to Unpublish a Site 
 

If you've Published a site and want to reverse that, you can very easily take the site down by 

unpublishing it. Go to the Settings tab in the editor.    

 

 

 

Select the Archive / Un-publish section.  And then click Un-publish Site.  

 

 

A dialog box will ask you to confirm you want to do this -- after you confirm, the site will be 

unpublished.  If you want to Publish it again, just click the Publish button as usual.  

 

 

 


